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ABOUT THIS GUIDE

This manual describes Internet Camera, including a
description of the features, as well as the installation
procedures and web configuration. Included in the

manual are the operating procedures for the IPView
application.
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INTRODUCTION

Thank you for the purchase of the Internet Camera
connecting directly to an Ethernet or Fast Ethernet. Itis
different from the conventional PC Camera, the Internet
Camera is a standalone system with built-in CPU and
web-based solutions providing a low cost solution that
can transmit high quality video images for monitoring.
The Internet Camera can be managed remotely, accessed
and controlled from any PC/Notebook over the Intranet
or Internet via a web browser. The simple installation
procedures and web-based interface offers easy
integration to your network application environments
coupled with many applications such as remote
monitoring for a cost-effective solution.



SYSTEM
REQUIREMENT

Internet Camera

Network:

Local Area Network:

10Base-T Ethernet or 100Base TX Fast Ethernet

Recommended PC or Notebook to
Access the Internet Camera

Web Browser:
System requirement:
CPU: Pentium 11, 266 MHz or above
Memory Size: 32 MB (64 MB recommended)

VGA card resolution;  800x600 or above
7



?? Internet Explorer 5.0 or above (ActiveX & JAVA Mode—
Image View for Windows OS and JAVA Mode — Image
View for other OS)

?? Netscape 6.0 or above (JAVA Mode — Image View)

IPView Application:

Support OS; Win 98, Win 98 SE, Win 2000, Win Me, Win XP
System requirement for IPView:
CPU: Pentium 111, 450 MHz or above
Memory Size: 128 MB (256 MB recommended)
VGA card resolution:  800x600 or above
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FEATURES AND
BENEFITS

This section describes the features and benefits of the Internet
Camera

Simple To Use

The Internet Camera is a standalone system with built-in CPU
requiring no special hardware or software such as PC frame
grabber cards. The Internet Camera supports both ActiveX mode
for Internet Explorer and Java mode for Internet Explorer and
Netscape Navigator. Therefore, all that is required is a web
browser software such as Internet Explorer 5.0 or above or
Netscape 6.0 or above. Just plug and view the picture from your
Internet Camerawith avalid IP Address.



Support Variety of Platforms

Supporting TCP/IP networking, SMTP email, HTTP and other
Internet related protocols. The Internet Camera can be utilized in
a mixed operating system environment such as Windows, Unix,
and Mac. It can be integrated easily into other www/Intranet
applications.

Web Configuration

Applying a standard web browser, administrator can configure
and manage the Internet Camera directly from its own web page
via the Intranet or Internet. Up to 64 users name and password
are permitted with privilege setting controlled by the
administrator.

Remote Utility

Powerful IPView application assigns administrator with a pre-
defined user ID and password whom can modify the Internet
Camera settings from the remote site via Intranet or Internet.
When new firmware is available you can also upgrade remotely
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over the network for added convenience. Users are also allowed
to monitor the image, and take snapshots.

Connection to External Devices

Supporting auxiliary Input/Output Connector, you can connect
the Internet Camera to a variety of externa devices such as IR-
sensors, switches and adarm relays. One can combine with
programmable alarming facilities to develop a variety of security
applications that are triggered on aarm-based events. The
Internet Camera provides up to two in/out externa devices for
connectivity.

Broad Range of Applications

With today’s high-speed Internet services, the Internet Camera
can provide the idead solution for live video images over the
Intranet and Internet for remote monitoring. The Internet Camera
allows remote access from a web browser for live image viewing
and dlows adminidtrator to manage and control the Internet
Camera anywhere and any time in the world. Apply the Internet
Camera to monitor various objects and places such as homes,
offices, banks, hospitals, child-care centers, amusement parks and
other varieties of industrial and public monitoring. The Internet
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Camera can aso be used for intruder detection, capture still
images for archiving and many more applications.



PHYSICAL
DESCRIPTION

This section describes the externaly visible features of the
Internet Camera.

Front Panel

Power LED LAN LED




Power LED

The Power LED is positioned on the right side of the Internet
Camera's lens while facing the Internet Camera.

Steady blue confirms the Internet Camera is powered on.

Note:
There are three settings for the Power LED to control the light

illumination for monitoring purpose from Normal / Off / Dummy.
Please refer to the Web Configuration section for detailed
information and usage.

LAN LED

The LAN LED is positioned on the far right side of the Internet
Camerd's lens while facing the Internet Camera. It is located
right of the Power LED

Steady orange confirms good connection to LAN connectivity.

Dependent on the data traffic the LED will begin to flash to
indicate the Internet Camera is receiving/transceiving from/to the
LAN or network.

Note:

There are three settings for the LAN LED to control the light
illumination for monitoring purpose from Normal / Off / Dummy.
Please refer to the Web Configuration section for detailed
information and usage.

14



Rear Panel

Network Cable DC Power
Connector Connector

nad@EkETN
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Reset Button 1/O Connector

Network Cable Connector

The Internet Camera's rear panel features an RJ-45 connector for
connections to 10Base-T Ethernet cabling or 100Base-TX Fast
Ethernet cabling (which should be Category 5 twisted-pair cable).
The port supports the NWay protocol, alowing the Internet
Camera to automatically detect or negotiate the transmission
speed of the network.

15



DC Power Connector

The DC power input connector is located on the Internet
Camerd's rear panel and is labeled DC 5V with a single jack
socket to supply power to the Internet Camera. Power will be
generated when the power supply is connected to awall outlet.

Reset Button

Reset will be initiated when the reset button is pressed once and
Power LED begins to flash.

Factory Reset will be initiated when the reset button is pressed
continuoudly for three seconds or when Power LED begins to
light up. Release the reset button and the Power LED will begin
to flash indicating the Internet Camera is changing to factory
reset. When factory reset is completed the IP address will return
to the default setting as 192.168.0.20.

/O Connector

There are four I/O connectors, two for input and two for output
gtuated on the rear panel. The 1/O connectors provide the
physical interface to send and receive digital signals to a variety
of external alarm devices. Please refer to the User’s Guide
appendix for detailed information.

16



Top Panel

Screw Hole

Screw Hole

Located on the top panel of the Internet Camera the screw hole is
used to connect the camera stand onto the Internet Camera by
ataching the screw head on the camera stand into the screw hole
of the Internet Camera.

Bottom Panel




Screw Hole

Located on the bottom pand of the Internet Camerathe screw
hole is used to connect the camera stand onto the Internet Camera
by attaching the screw head on the camera stand into the screw
hole of the Internet Camera.

18
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UNPACKING THE
INTERNET CAMERA

Carefully remove al items from the package. In addition to this
User’s Guide, be certain that you have:

INTEN TN N

7?

One Internet Camera

One Installation CD-ROM

One Quick Ingalation Guide

One AC power adapter suitable for your country’s
electric power

One Camera Stand

If any item is missing, or if you find any damage or mismatch,
promptly contact your dedler for assistance.

19



Connecting the Internet Camera
to the Camera Stand

The Internet Camera comes with a

camera stand (optional) with a swivel "
ball screw head that can be attached o |
to the Internet Camera's bottom H
screw hole. Attach the camera stand to

the Internet Camera and station it for

your application. There are three holes

located in the base of the camera stand

alowing the Internet Camerato be

mounted on the celling or any wall

securely.



HARDWARE
INSTALLATION

This section describes the Hardware installation procedure for the
Internet Camera.

1 Connect an Ethernet cable

Connect an Ethernet cable to the

network cable connector located /

on the Internet Camera’ s rear Ay
panel and attach it to the network. Py

21



2 Attach the external power
supply

Attach the external power

supply to the DC power input ([
connector located on the A
Internet Camera’ s rear panel ==

and islabeled DC 5V and connect /_lﬁg H‘w i

it to your loca power supply.

Note:
Confirm power sourceis supplied /

from the LED indicators label Power S’
on the Internet Camerais illuminated.
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SECURITY

To ensure the highest security and prevent unauthorized usage of
the Internet Camera the Administrator has the exclusive privilege
to access the System Adminigtration for settings and control
requirements to alow users the level of entry and authorize the
privileges for al users. The Internet Camera supports multi-level
password protection and access to the Internet Camera is strictly
restricted to defined users whom has a "User Name" and "User
Password" which is assigned by the Administrator.

Adminigtrator can release a public user name and password so
when remote users access the Internet Camera they will have the
right to view the image transmitted by the Internet Camera.

Note:

When the Internet Camera is used for the first time it is highly
recommended the Administrator sets the "Admin ID" and "Admin
Password" to constrain users access to the Internet Camera since
the Default settings are Null String. Once the ID and Password
are defined only the Administrator has the access to management
the Internet Camera. This procedure should be done as soon as
possible since the security features with the Internet Camera will
not be enabled until the "Admin ID" and "Admin Password" is
defined.
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SOFTWARE
INSTALLATION

This section describes the Software installation procedure of the
Internet Camera for Web Configuration and IPView Application.

Web Configuration

The Internet Camera must be configured through its built-in Web-
based Configuration.

Extensive knowledge of LAN will be hepful in setting up the
Internet Camera

From the web browser enter the default |P address to access the
Welcome screen of the Internet Camerato configure your Internet
Cameratype http ://192.168.0.20 in the address box. The number
is the default | P address of your Internet Camera. Press Enter.
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Note:

The PC's IP address must correspond with the Internet
Camera's IP address in the same segment for the two devices

to communiceate.
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Main Menu Image

After the default IP address is entered from the browser the
Internet Camera’ s Welcome screen will appear with a still image.
There will be three options to choose from to set-up and view
your Internet Camera and they are as follows:

e View Image — ActiveX Mode

#& View Image — Java Mode

&z System Adminigtration

26



System Administration

Click on “System Administration” from the Welcome screen to
access the settings required for the Internet Camera.

There will be severa options in the System menu bar to choose
from to set your Internet Camera and they are as follows:

&5 System
&5e5 Image
e Users
e DateTime
e Trigger
=& Information
&z Tools

System Administration

System Administration - System

The System menu contains commands for settings that are

required for inputting key details to set-up the Internet Camera
for operation.
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Click on " System” in the system administration menu bar and
the System screen will appear asillustrated below:
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CameraName:
Thisfield is used for entering a descriptive name for the device.
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The default setting for the Camera Name is CS-xxxxxx, where
XxXxxxX is the last six digit of the MAC Address. The maximum
length is 32 (Printable ASCII).

L ocation:
This field is used for entering a descriptive name for the location

used by the Internet Camera.

Admin:

Thisfield is used for entering the Administrator 1D aong with the
password to access the System Administration settings. Be sure
to enter the password twice to confirm the details once in the
Admin Password field and again in the Confirm Password field.

The default setting for Admin is blank space (Null String) you
need to key in the Admin ID with a maximum length of 12
(Printable ASCII) characters and enter the Admin Password with
amaximum length of 8 (Printable ASCII) characters.

It is highly recommended to set the Admin ID and Admin
Password as soon as possible to enable security option for the
Internet Camerato function.

I P Assignment:

Important Information
Access to the Internet Camera is done through assigning a proper IP
address. Please make sure to use a vacant |P address when you assign
the IP address for the Internet Camera. This will prevent errors from
occurring if the IP addressis overlapped.




There are two options to select from the IP Assignment either
Manually Assign or Assign Automatically Using.

Manually Assign

You can click “Manually Assign” and directly enter the IP
address.

The default settings are as follows:

?? Default IP—192.168.0.20
?? Subnet Mask — 255.255.255.0
?? Default Gateway — 0.0.0.0

Assign Automatically Using

If your network isusing RARP, BOOTP or DHCP server you can
click “Assign Automatically Using” and click on “RARP”,

“BOOTP” or “DHCP”. Under this setting the Internet Camera
will automatically assign an IP address from RARP, BOOTP or

DHCP server. Each time the Internet Camera starts up be sure
the RARP, BOOTP or DHCP server is setup as assign a static 1P
to your Internet Camera.

If your application requires direct connection from an ADSL
modem through the Internet Camera's RJ-45 LAN port and you
also have an ISP PPPoE account. Click on “PPPOE” option and
enter the Service Name, User ID and Password into the respective
fields.

The Internet Camera will get an IP address from the ISP each
time the Internet Camera starts up.
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DNSIP Address:

DNS (Domain Name System) server is an Internet service that
trandates domain names into IP addresses. Enter at least one
DNS IP Address.

LED Control:
The LED control alows user to setup the LED illumination as
desired. This feature provides the flexibility when surveillance
activity is ON.
There are three options as follows:
&5 Norma —
Power - Steady On of the LED indicator.
LAN - Steady On of the LED indicator. When
LAN activity is present the LED indicator will
flash steadily.
&5 OFF —
Power - LED indicator is off
LAN — LED indicator is off
& Dummy —
Power - Steady On of the LED indicator.
LAN - Steady On of the LED indicator with
random flashing.

The default setting for the LED control is a Normal. When you
have configured the LED control the correct illumination will set
in after 1 minute.

Note:
This function is built-in to the LED indicators to add extra

capabilities. The three options alow the Administrator to
configure and camouflage the illumination for the LED indicator
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to fadfy the monitoring status. In Norma Mode the LED
indicator functions as normdly. Under Off Mode the LED
indicators are both off however, it is still monitoring the activity.
In Dummy Mode the LED indicators operate in monitoring
condition but monitoring activity is off or on.

L oading ActiveX From:

This field is used to specify the location of Xplug Control
(ActiveX) plug-in program. Enter the information as required in
.ocx format, for example:

http://www.<your  company>.com/xplug.ocx where <your
company> must be replaced with your company’s DNS server.

Open Second Port:

The Web Server field alows settings to open a second port for the
Internet Camera. Thiswill permit users |P Sharing Gateways to
support multiple Internet Cameras. By default Port 80 is dways

opened for the Internet Camera Web Server access. Select
“Yes” and input the second port value.

For example: If you have 5 Internet Camerasto be ingtalled, each
with an IP address from

192.168.0.101
192.168.0.102
192.168.0.103
192.168.0.104
192.168.0.105

Y ou can open the second port for each Internet Camera from port
81 to Port 85 as illustrated below:
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Internet Camera 1 — IP 192.168.0.101, second web port 81
Internet Camera2 — 1P 192.168.0.102, second web port 82
Internet Camera3 — IP 192.168.0.103, second web port 83
Internet Camera 4 — 1P 192.168.0.104, second web port 84
Internet Camera5 — 1P 192.168.0.105, second web port 85

You aso need to setup your DSL gateway for Port Mapping.

Port 81 map to 192.168.0.101
Port 82 map to 192.168.0.102
Port 83 map to 192.168.0.103
Port 84 map to 192.168.0.104
Port 85 map to 192.168.0.105

The Transfer Image field allows settings to open a second port for
the Internet Camerato transfer images. The default Port 8481 is
open image transfer and you can define a second port smilar to
the above.

Save/Cancel:
After making sure dl settings in the System are correct, click on

the “ Save” icon to store the settings for the Internet Camera
You can dternatively click on the “Cancd” icon to restore al
settings to the values last saved to or retrieved from the Internet
Camera



System Administration - Image

Image menu in the system administration contains commands to
provide the settings for the images captured by the Internet
Camera

Click on “Image” in the system administration menu bar and the
Image screen will appear asillustrated below:
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Video Resolution:
Select the desired video resolution format ranging from 160x112,
320x240 (default) or 640x480

Compression Rate:

Select the desired compression rate with five levels from very low
to very high. Higher video compression rate will generate more
compact file size with less video quality and vise-versa. The
default setting is at Medium.



Frame Rate:
Select the frame rate desired with default setting at Auto for
optimal frame rate.

Brightness Control:
Adjust the brightness level with default setting at 64.

Contrast Control:
Adjust the contrast level with default setting at 64.

Hue Control:
Adjust the hue level with default setting at 64.

Light Frequency:
Adjust the light frequency to suit your area of operation from the
options either 50 Hz or 60 Hz (default).

Note:

50 Hz and 60 Hz variants are available to accommodate the
different light frequency found in USA (60 Hz) and Europe (50
Hz) for the Internet Camera to ensure better image quality.

Save/Cancel:
After making sure all settings in the Image are correct, click on

the “Save” icon to store the settings for the Internet Camera.
You can dternatively click on the “Canced” icon to restore all

settings to the values last saved to or retrieved from the Internet
Camera



System Administration - Users

The User options menu contains commands to allow system
administrator to assign legal users who are permitted to monitor

the Internet Camerafrom the remote site.

Click on “Users’ in the system administration menu bar and the
Users screen will appear asillustrated below:

bl Ui Hame

Taer Passwerd
T2 Cuipart Cantrol Yy *Wa

Click on“Home’
to return to
Welcome Screen
Add User:
User Name:

Enter the user name in thisfield.

A maximum of 64 users names are adlowed, however each users
name must be different. Each user name can be used as a group
given the password for example, if the User Nameis “ Guest” and
the User Password is “Guest” anyone can access the Internet
Camera with these details used as a group of users under the
User Name Guest. The maximum length for the User Nameis 12
(Printable ASCII).
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User Password:
Enter the user's password assigned by the administrator. The
maximum password length is 8 (Printable ASCII).

I/O Output Control:
Administrator has the authority to give permission for the

privilege to contral the 1/0 Output Control to user’s by selecting
“Yes” or “No” to activate the 1/0O Output contral.

To add a new users name input the necessary information first
and click on the“ Add” icon.

Delete User:
Select the user you wish to delete from the pull down menu and
click onthe“ delete” icon.

Important Information
Once administrator has configured the Internet Camera Users.
any user will be required to enter a login password to access the
video image of the Internet Camera The password dialog box
isillustrated below.

Enter Metwork Passwaond
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System Administration — DateTime

The DateTime menu contains commands for setting the Internet
Cameras time and date requirements to provide correct
information to users who might be thousands of miles away in the
remote Site.  There are two options to select from the DateTime
menu bar either Synchronized with Time Server or Set Manually.

Click on “DateTime’ in the system administration menu bar and
the DateTime screen will appear asillustrated below:
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Screen
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DateTime:
Select “ Synchronized with Time Server” and the time will be
based on GMT setting. The time will be synchronized every 10

minutes. Thisisaso the default setting for the Internet Camera

IP Address:
Enter the |P Address of the Time Server in thisfidd.
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Protocol:
Two options of NTP or Time are available for your sdection to
link with the Time Server. The default setting isNTP.

TimeZone:
System administrator must select the time zone for the region.

Please refer to the appendix for the time zone selection table.

To set the Date Time manualy sedlect “Set Manually” and
system administrator must enter the Date and Time in the
respective field manually.

Note:

When you sdlect Set Manually, each time the Internet Camera is
powered off and on you must re-enter the details once again due
to time lost.

Save/Cancel:
After making sure dl settings in the DateTime are correct, click

on the “ Save” icon to store the settings for the Internet Camera
You can dternatively click on the “Cance” icon to restore all

settings to the values last saved to or retrieved from the Internet
Camera

System Administration — Trigger

The Trigger menu contains commands for the 1/O Trigger
connectors providing the physical interface for 2 digital output
and 2 digital input that is used for connecting a diversity of
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externa aarm devices to the Internet Camerasuch as |R-Sensor
and darm relay.

Click on “Trigger” in the system administration menu bar and
the Trigger screen will appear asillustrated below:
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The default setting for the 1/0O Trigger functions are disabled you
must enable the I/O Trigger first before the Triggers will perform.

There are two options to select from the Trigger screen /0 Input
1Triggerand /O Input 2 Trigger.

/O Input 1 Trigger:
Select “ Send e-mail attached with image” and enter the relevant
information such as the SMTP Server Address, Sender emall
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Address, Receiver email Address, Sending Interval and Sending
Times.

?? SMTP (Smple Mail Transfer Protocol) is a protocol for
sending e-mail messages between servers you need to
input the mail server addressin thisfield.

?? Sender e-mail is the person’s email address whom will
be sending the e-mail.

?? Receiver e-mail is the e-mail address of the person
whom will receive the e-mail.

?? Sending Interval is the period of time between each e
mail keing sent to the receiver. If the setting is at 10
seconds, a new e-mail will be sent in 10 seconds interval
to the receiver.

?? Sending Time is the number of times the email will be
sent to the receiver before it terminates.

Select “Trigger 1/0 Output” and enter the setting for the
duration of the output device for Output 1 time and Output 2 time
in seconds.

/O Input 2 Trigger:
Select “ Send e-mail attached with image”’ and enter the relevant

information such as the SMPT Server Address, Sender emall
Address, Receiver email Address, Sending Interval and Sending
Times.

?? SMTP (Smple Mail Transfer Protocol) is a protocol for
sending e-mail messages between servers you need to
input the mail server addressin thisfield.

?? Sender e-mail is the person’s email address whom will
be sending the e-mail.
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?? Receiver e-mail is the e-mail address of the person
whom will receive the e-mail.

?? Sending Interval is the period of time between each e
mail being sent to the receiver. If the setting is a 10
seconds, a new e-mail will be sent in 10 seconds interval
to the receiver.

?? Sending Time is the number of times the email will be
sent to the receiver before it terminates.

Select “Trigger 1/0 Output” and enter the setting for the
duration of the output device for Output 1 time and Output 2 time
in seconds.

Save/Cancel:
After making sure dl settings in the System are correct, click on

the “Save” icon to store the settings for the Internet Camera.
You can dternatively click on the “Cancel” icon to restore dl
settings to the values last saved to or retrieved from the Internet
Camera.

Warning
When connecting other devices through the 1/O connectors, please
make sure the maximum current of 100mA is strictly observed.
Any failure to do so might cause a loss of power to the Internet
Camera and possibly cause serious damage to the Internet Camera.

Please refer to the appendix for detailed information regarding
the 1/0 Connector.
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System Administration - Information

The Information menu contains commands for displaying
information about the Internet Camera

Click on “Information” in the system administration menu bar
and the Information screen will appear asillustrated below:

Wt LEC-3nns

R[]

OO'FF 6508 EB 51

Click on“Home”
192 1680250 toreturn to
Welcome Screen

The Information table provides detailed information of the
Internet Camera such as the Model Name, Firmware Version,
Mac Address, and |P Address.

System Administration - Tools

The Tools menu contains commands for restarting the Internet
Camera



Click on “Tools” in the system administration menu bar and the
Tools screen will appear asillustrated below:

Do yealreally Wag 0o Rotoey fiset des deqret | VES

Click on“Home’
to return to
Welcome Screen

Reset:

The Reset command restarts the Internet Camera just like
turning the device off and on and saved settings are retained. The
Reset pandl contains the message “Do you realy want to reset
this device?” and a YES button. If you do rot want to reset the
Internet Camera, exit the panel without clicking Y ES, otherwise,
click onthe“YES’ icon and the reset process will initiate.

Factory Reset:

A factory reset restarts the Internet Camera and returns dl of its
settings to their default values. The Factory Reset panel contains
the message “Do you readlly want to factory reset this device?’
and a YES button. If you do not want to carry out a factory reset
command, exit the panel without clicking YES, otherwise click
onthe“YES’ icon and factory reset will be initiated.

Note:
The Network must be reconfigured after a Factory Reset.

Once the configuration is completed click on “Home” to return to
the Welcome screen and select the desired Viewing Image either
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through ActiveX Mode or Java Mode as described in the next
section.

Then postion the Internet Camera to the desired location
appropriately for your purpose. Followed by adjustment of the
Internet Camera focus, done manualy by turning the lens
clockwise or anti-clockwise to the desire image quality. Please
refer to the appendix for detailed information regarding Adjust
Internet Camera Focus and Replacing the Lens.

View Image — ActiveX Mode

To view video images from the browser, click on “View Image —
ActiveX Mode’ from the welcome screen to access the video
images from Internet Explorer asillustrated bel ow:

pos-inE 44— CameraName* o ourime 1 T [O0] [OFF] (oRET
Celknnon Systems Inc. FM-TEST ‘ L ocation* * s 2 T 00| OFE] [¥E)

2001-12-05 16398

Click on“Home’ to
return to Welcome

Screen




Camera Name* - The Camera name will be display when the
Camera Name field is entered in the Web Configuration setting
under “ System”

Location**- The location of the Internet Camera will be
displayed when the Location field is entered in the Web
Configuration settings under “ System” .

Note:

Please refer to the appendix on how to install ActiveX.
1. Install to the Web Server
2. Install to your Local PC

In the View Image — ActiveX Mode you are alowed two output
trigger options. Just click on the desired selection “ON” or
“OFF” to utilize the options for each of the output triggers
(Output 1 trigger or Output 2 trigger).

Note 1.

Output trigger will send a 5V signd to the device mnnected to
the Internet Camera. A maximum of two devices is permitted to
connect to the Internet Camera to utilize the output trigger
function. Please refer to appendix for detailed information.

Note 2:

Administrator has the authority to allow user’s the permission to
set the output trigger functions through the setting in the “Users’
of System Administration menu bar.



View Image — Java Mode

Click on “View Image — Java Mode” from the Welcome screen
to access the video images from the Internet Explorer or Netscape
browser asillustrated below:

[25-1000w ' Ca'rnera Narne* PR T ERTT o
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Clickon“Home” to
return to Welcome
Screen

Camera Name* - The Camera name will be display when the
Camera Name field is entered in the Web Configuration setting
under “ System”

Location** - The location of the Internet Camera will be
displayed when the Location fied is entered in the Web
Configuration settings under “ System” .

In the View Image — Java Mode you are allowed two output
triggers. Just click on the desired selection “ON” or “OFF” to
utilize the options for each of the output triggers (Output 1 trigger
or Output 2 trigger).
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Note 1.

Output trigger will send a 5V signal to the device connected to
the Internet Camera. A maximum of two devices is permitted to
connect to the Internet Camera to utilize the output trigger
function. Please refer to appendix for detailed information.

Note 2:

Administrator has the authority to allow user’s the permission to
set the output trigger functions through the setting in the “Users’
of System Administration menu bar.



INTERNET CAMERA
APPLICATION

The Internet Camera can be applied in wide variety of
applications. It is an all-in-one device attached directly to an
Ethernet or Fast Ethernet network. It is a standalone system with
built-in CPU aong with web-based solutions transmitting high
quality video images for monitoring purposes. It can be managed
remotely, accessed and controlled from any PC desktop over the
Intranet or Internet via a web browser. With the easy ingtalation
procedure real-time live images will be available once the
Internet Camera s installed coupled with the IPView application
you can further expand the scope of the Internet Camera

The following section will provide typical applications for the
Internet Camera along with the IPView applications and
includes some basic knowledge to assg in the ingtdlation and
configuration of the Internet Camera.



Applications

?? Monitoring of local and remote places and objects such as
congtruction sites, hospitals, amusement parks, schools
and day-care centers through the use of a web browser.

?? From the IPView application you can capture single
frame images.

?? Connect up to two external devices to the Internet
Camera for aarm notifications when a trigger is
activated you can configure to send-mail messages with a
single frame image.



Internet Camera Application
Diagrams
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SOHO Applications
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Enterprise Applications

ENTERPISE




I/O Connector Application

Wireless Internet Camara

Wireless Internet Camera

Wiraless Internat Camera

Wirelegs Internat Camera
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AUTO-RUN
INSTALLATION

Insert the CD-ROM into the CD-ROM drive to initiate the auto-

run program once completed a menu screen will appear as
follows:

3 | Users Guide
1PView

Xplug Comtrol
Browse CD
EXIT




Then select the desired options from the menu buttons and they
are asfollows:

?? User's Guide
?? IPView

?? Xplug Control

?? Adobe Acrobat

?? Browse CD

?? Exit

To preview the Usar's Guide in .pdf format for detailed

information regarding the installation procedure for the Internet
Camerasmply click onthe" User's Guide" button.

To ingtall the IPView application click on the " IPView'" button
to activate the installation procedure for the application program.
Please refer to the next section for detailed information for
installing IPView application.

To ingtall Xplug Control (ActiveX) plug-in program into your
PC/Notebook click on the " Xplug Control” button to activate
the installation procedure for the plug-in program. Please refer
to the appendix for detailed information regarding Installation of
Xplug Control (ActiveX) into your PC/Notebook or Web Server.

If you do not have Adobe Acrobat Reader instaled in your
PC/Notebook click on the " Adobe Acrobat” button to activate
the installation procedure. This will allow you to preview the
User's Guide for the Internet Camera

56



If you wish to glance the contents of the CD-ROM click on the
"Browse CD" button and the content of the CD-ROM will be
available for preview.

To exit the CD-ROM just double click onthe™ EXIT" button.
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IPVIEW APPLICATION
INSTALLATION

Installation

Insert the CD-ROM into the CD-ROM drive to initiate the auto-
run program. Once completed a menu screen will appear as
follows:

1

Lisers Guide
1PView

Xplug Contrel
Browse CD
EXIT




To install the IPView Application click on the " IPView" button
to activate the installation procedure for the application program.

Once executed a prompt will appear requesting the input of the
desired language selection. Make the desired selection and click
on*“ OK” to continue.

Choosge Setup Language

Select the lanauage for this installation fram
W the choices belaw.

ok | Concel

The Welcome screen will appear. Click on the “Next” button to
proceed with the installation.

Imag bl hisld s and | x|
@ Weloame b B s il he W W id b FView

T e el S "l vl il | P o Lo
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e R |
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The License Agreement prompt will appear as below. Read the
details carefully and click on the “Yes’ icon to continue with the
installation procedure.
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A prompt will gppear and in the Destination Location dialog box,
you may click on “Next” to accept the recommended destination
location or click on “Browse” to select another location. After
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specifying the desired destination location, click on “Next” to
proceed further.
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The Select Program Folder prompt will appear providing
information of where the IPView application will be located,
clickon “Next” to continue. If you wish to modify your settings,
click on “Back” to return to the previous screens.
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Please wait until one of the two dialog box to appear, select either
“Yes, | want to restart my computer now” and click on the
“Finish” icon to restart the computer to complete the installation
procedure.
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or click on the “Finish” icon to complete the installation
procedure
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After successfully installing the 1PView, the application program
for the Internet Camera is automaticaly installed to
\Programs\Files Directory.

To sart running the IPView click on windows Start
M enu/Programs/I PView/I PView

Once IPView is executed a Login prompt will appear, you must
enter the default User Name: admin into the respective field and
click on “ OK” to log into the gpplication.




Once login, the IPView application is executed and the IPView
interface will appear as follows in the default List View format:
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IPVIEW — GETTING
STARTED

This section describes the operation of the IPView application
User Interface with detailed procedures for using the application.

IPView

IPView is responsble for the management of preview,
configuration, and searching of each camera.

It is designed with a user-friendly interface for ease of control and
navigation requirements as illustrated below.
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List vi ew format

How to Change Password

Change Password

When IPView is used for the first time it is highly recommended
to change the Usr Name and Password by the Administrator to
constrain users access to the IPView application. Once the User
Name and Password are defined only the Administrator has
access to the management of IPView applications.  This
procedure should be done as soon as possible to prevent
unauthorized usage of IPView application.



Once IPView is executed a Login prompt will appear, you must
enter the default User Name: admin into the respective field and
clickon “OK” to log into the gpplication.

o

s Ham e

s [
[ ] o |

To change the Usr Name and Password select “Tools’ >
“Options’. The Options didog box will appear as illustrated
below.
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The administrator needs to enter a Ussr Name, Password and
Confirm password into the respective fields. Once al the new
details are entered click on the“ OK” icon.

Make sure to save any changes you have made to keep the
information updated.

Note:

Alternatively you can click the Options icon L asillustrated or
usethe hot key “F10”.

How to Change IP Address

Change IP Address

To change an IP Address for a camera sdect “Camera’ >
“Add”. An Add Camera diadog box will appear as illustrated
below.

B Sl Camers




Click onthe “Browse” icon, the Browse Camera dialog box will
appear with ablank screen asillustrated below.

sl | o | et | e

Click on the“ Search” icon and IPView will detect and search all
the available camerd s that are instaled on the loca area network
as depicted below:
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Y ou must highlight the camera you wish to change the IP Address
and click on the “Change IP” icon and the Change IP Address
dialog box will appear as depicted below:

w. Change IP Address =1

1P Address: I

“Subnet Mask: i

Defaulk Gateway: l

Enter the new IP Address aong with the Subnet Mask and
Default gateway into the respective fields and click on the “ OK”
icon and IPView will automatically change the IP Address.

Make sure to save any changes you have made to keep the
information updated.

How to Add a Camera

Add Camera

To add a new camera sdect “Camera’ > “Add”. An Add
Camera didog box will appear asillustrated below.
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% Add Camera

You can enter the IP Address of the camera in the specified field
and click the“Add” iconto add anew camera. If the IP Address
is entered incorrectly a dialog box will appear to notify the error.

IPYiew

Irvvalict [P Address, Try again

If you are unsure of the IP Address of the camera you can click
on the “Browse” icon, the Browse Camera diaog box will
appear with ablank screen asillustrated below.

I ]
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Click on the “ Search” icon and IPView will detect and search all
the available camerd' s that are installed on the local area network
as depicted below:

Town ke D255 24234 LELSR
LEC-VE00-2E838 0,128, 200530885, 56
LEC- K5 035722 LIEAT

wd | e |[TEE ] g |

You must highlight the camera you wish to add and click on the
“Add” icon. The Add Camera dialog box will appear once
again with the IP Address entered. Click on the “Add” icon and
the camera will be automatically added into IPView list view
format.

Alternatively you can double click on the camera you wish to add
and the Add Camera dialog box will appear once again with the
IP Address entered. Click on the“Add” icon and the camerawill
be automatically added into IPView list view format.
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# Add Camera

1P Address;

Add Cancel J -Browse, . J

If the Login Camera dialog box appears make sure to enter the
correct User Name and Password and click on the “OK™” icon
and the camera will be added into IPView in list format. If the
Usar Name and Password is entered incorrectly the camera will
not be added into IPView.

#) Login Camera E
User Mame: I
Passwmiord: |

(]S Cancel J

The above diadog box will appear only if administrator has
aready set the Usr Name and Password during the Web
Configuration setting.

If you forget to highlight the camera you wish to add a dialog box
will appear to notify you of the error.

IPView

Flease select the camera pou want.
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Make sure to save any changes you have made to keep the
information updated.

Note 1:
You are only able to add one camera at atime.

Note 2:

Alternativelv you can click the Add icon & asillustrated or use
the hot key “ Shift+Ins’.

How to Delete a Camera

Delete Camera

To delete a camera you must highlight the camera you wish to
delete from IPView list view format. From the menu bar sdlect
“Camera” > “Delete’. A Delete Camera dialog box will
appear and click on the “Yes’ icon to delete the camera or click
on “No” if you do not wish to delete the camera as illustrated
below.

Delete Camera

[l pou want ko delste the camera?

Make sure to save any changes you have made to keep the
information updated.

Note:
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Alternatively you can click the Del ete icon & asillustrated or
use the hot key “ Del” .

How to View a Camera

View Camera

From the menu bar sdlect “View” > “4 Cameras’ (other choices
areavailablein 1 Camera, 9 Cameras and 16 Cameras viewing
format) and the viewing screen will appear with the video image.

Note:
The icon on the upper |eft corner of the screen will appear with
the camera number that is being displayed

To return to the IPView list view formet, click on the icon located
on the upper left corner of the screen and a case sensitive menu
will appear. Select “List” and the viewing image will return to
the list view format.
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Note 1:

A maximum of 16 cameras are available for viewing with the
IPView application.

Note 2: .

Alternatively you can click the 1 Camera icon ! asillustrated
or use the hot key “Ctrl+F3”. For 4 Cameras = , 9 Cameras

:&l and 16 Cameras '-E-j click the respective icon or use the hot
key asfollows“ Ctrl+F4”, “Ctrl+F5" and “ Ctr|+F6”. Toreturn
to list view format use the hot key “ Ctrl+F1”.

How to Snap shot a Camera

Snap shot Camera

To snap shot a camera you must highlight the camera you wish to
snap shot from the list view format. From the menu bar select
“Camera’ > “Snap shot”. A Save Image dialog box will
appear for you to save the snap shot picture.

A second dternative is from the viewing mode either 1, 4, 9, 16
cameras click on the icon located on the upper |eft corner of the
screen and a case sensitive menu will appear and select the “ Snap
shot” icon. A Save Image dialog box will appear for you to save
the snap shot picture.

Note:

Alternatively vou can click the Snap shot icon < asillustrated
or usethe hot key “F5”.
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How to Adjust the Property
Setting

Property Setting

“Property” is initiated by selecting “Camera” > “Property”

and a didog box will appear dlowing settings of Web
Configuration and upgrade firmware (Please refer to the appendix
for detailed information). The Camera Property dialog box will
appear for you to select the desired options from the tab selections
to Configure the camera as shown below.

General
Allows settings for the camera name, location and administrator

information such as administrator 1D and password. Please refer
to the Web Configuration section under “ System Administration
— System” for further detalls.



(EELTTTEEE— k|
DubfTras | Tegomd | Tagow: | Irfermabin Tk
Gorwed | ir nasgrunat: | v | wietens | Mo | drage | e

Comeafma) =3B

Locaoa | el Ty
[
v [B I
v P - I—
Famppad Candinre I—

T e -

P Assignment

There are two options to select from the IP Assgnment either
Manually Assign or Assign Automatically Using. Please refer
to the Web Configuration section under “ System Administration
— System” for further details.
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DNS

DNS (Domain Name System) server is an Internet service that
trandates domain names into IP addresses. Enter at least one
DNS IP Address. Please refer to the Web Configuration section
under “ System Administration — System” for further details.
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Wireless
(Please skip this section if your camerais not wireless)

Allows setting for connection mode, network name, wireless
channel, and WEP key. Please refer to the Web Configuration
section under “System Administration — System” for further
details.
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Misc
Allows setting for LED Control, ActiveX control location, and

second port. Please refer to the Web Configuration section under
“System Administration — System” for further details.
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Image

Image provides the settings for the video image of the camera
such as brightness, contrast, hue, resolution, compression, frame
rate, and light freq. Please refer to the Web Configuration section
under “ System Administration — Image” for further details.
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Users

Contain commands to alow system administrator to assign legal
users who are permitted to monitor the camera from the remote
steby Add or Delete user.
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To add a user click on the “Add” icon and the Add User diadog
box will appear. Enter the User Name and Password into the
specific field. Select the 1/0 Output Control to give users the
privilege of accessing the 1/0 Output Control.
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T

To delete a user, select the user and click on the * Delete” icon.

Please refer to the Web Configuration section under “ System
Administration — Users” for further details.

Date/Time



Contain commands for setting the camera's time and date to
provide correct time information to users who might be thousands
of miles away in the remote site by selecting Synchronized with
Time Server or Set Manually. Pease refer to the Web
Configuration section under “System Administration —
TimeDate” for further details.
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Trigger 1

Contains commands for setting the /O Trigger connectors
providing the physical interface for 1 digital output and 1 digital
input that is used for connecting a diversity of externa aarm
devices to the camera such as IR-Sensor and adlarm relay. Please
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refer to the Web Configuration section under “System
Administration — Trigger” for further details.
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Trigger 2

Contains commands for setting the 1/O Trigger connectors
providing the physical interface for 1 digital output and 1 digital
input that is used for connecting a diversity of externa aarm
devices to the camera such as IR-Sensor and dlarm relay. Please
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refer to the Web Configuration section under “System
Administration — Trigger” for further details.
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Information

Displays information about the camera such as the mode,
firmware verson, MAC address, and IP address. Please refer to
the Web Configuration section under “ System Administration —
Information” for further details.
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Tools

Contains commands for reset the camera and update firmware
(plesse refer to the appendix for detailed information). Please
refer to the Web Configuration section under “System
Administration — Tools” for further details on reset.
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Make sure to save any changes you have made to keep the
information updated.

Note:

Alternatively vou can click the Property icon 2l asillustrated
or usethe hot key “F2”.

Menu Bar

The menu bar provides easier access for users to navigate the
IPView with different selections along with hot key capabilities
asfollows:
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Menu Bar - File

“File” on the menu bar provides“ New” ,“Open” , “ Save”, “ Save
As” and “Exit” for users to create new files, open existing files,
save files, and exit the IPView as depicted below.

Fia i Corwwa Joolt Help
Uil o i 120 5 8 8l 1
) Open CikDl
& paw s
S
Exd

Menu Bar — View

“View” on the menu bar provide users with management
capabilities for “Columns’, “Ligt”, “Camera” and “Refresh”.
You can view Camera in “1 Camera’, “4 Cameras’, “9
Cameras’, “16 Cameras’. The “View” menu bar is pictured
below.
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1 3 Cwese [ritl= ]
3] 16 o - DHbFE

2] Bawh Fi2

Columns



When “Columns’ is launched a dialog box will appear alowing
the option to choose the columns one would like to display in List
View asillustrated below.

5 Column SeHngs

Viewing Format

You can view the format in “List” view. The “Ligt” viewing
format allows easy management and control of each camera.

List View

“List” view is illustrated below for your reference. You are able
to ligt al the cameras and their properties such as the camera
name, |P address, user name, and location will be displayed for
ease of control and management.
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Note:

Right click the mouse pad on any kind of the camerawill bring up
a context sensitive menu which shows the actions you can apply
to the selected camera

Double click on the desired camera will bring up the Property
diaog box.

To update camera list view just click on the “Refresh” icon for
Redal Time Data and the latest information.

Menu Bar - Camera

“Camera’ on the menu bar provides options to manage the

camera. One can “Add” additional Camera with a maximum of

16 Camera alowed for viewing. Through the management
R



function one can “Delete” a camera, manage the “Property”,
“Enable” for real time and take a" Snap shot” image. The menu
bar isillustrated below:
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Enable Function

By default the video image is enabled. There will be a “ check”
next to the Enable command to show that the Enable function is
working. To disable rea-time image sdect “Camera’ >
“Enable” and real-time video image will stop and shutdown.

Menu Bar - Tools

"Tools" on the menu bar adlows administrator management of
the security settings such as User Name and Password to gain
access into the IPView application. From the menu bar select
"Tools’ > "Options' and a dialog box will appear.
Administrator can change the User Name and Password for
security settings to access the application.
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Menu Bar - Help

“Help” on the menu bar provides “Contents’ and “About” to

instruct users how to operate the camerain HTLM format. From

the menu bar select “Help” and can choose either “ Contents’ or
“About” as depicted below:
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IPView Icon Description

L Open anew file. Alternatively the hot key is Ctrl+N.

4 Open an exigting file. Alternatively the hot key is Ctrl+O.
& saveafile Altematively the hot key is CtrI+S

E List view format. Alternatively the hot key is Ctrl+F1.

I:E 1 Cameraview format. Alternatively the hot key isCtrl+F3.
H 4 Cameraview format. Alternatively the hot key isCtrl+F4.
i 9 Cameraview format. Alternatively the hot key is Ctrl+F5.

= 16 Cameraview forma. Alternatively the hot key is
Ctrl+F6.

] Refresh IPView application. Alternatively the hot key isF12.

& Add acamera Alternatively the hot key is Shift+Ins.

> Delete acamera. Alternatively the hot key is Del.
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Zl Property setting to configure the camera. Alternatively the
hot key is F2.

Sl snap shot to capture a single still image.  Alternatively the
hot key is F5.

4 Options to modify the User Name and Password for IPView.
Alternatively the hot key is F10.



Context Sensitive Menu

Inlist view format by highlighting a camera and right clicking the
mouse pad will bring up a context sensitive menu for features
such as “Add”, “Delete”, “Property”, “Enable’, and “Snhap
shot”.
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In view mode format click on the icon located on the upper left
corner of the screen and a case sensitive menu will appear as
illustrated below.

Features such as “Enable’, “Snap shot”, “List”, “1 Camera’,
“4 Cameras’, “9 Cameras’, “16 Cameras’, “Previous Page”
and “ Next Page” will be available.
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UNINSTALL IPVIEW
APPLICATION

Click on windows Start Menu / Settings / Control Panel. A
prompt screen will be displayed like the one below and double
click on the Add/Remove Programs icon.

Control Panel
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From the Add/Remove Programs Properties Menu, select
“IPView” asillustrated below.

Add/Remove Programs Properties E2
TristallUrinstal I Yfindows Setup i Startup Disk i

g@ Toinstall a new program from a floppy disk er COD-ROM
T

dritve; elick [nstall
Inistall..

T The follawing software can be automatically removed by

"Qg Windows: To remove a program or fo modify its installed
companehts, select it fram the list and click
Add/Remove,

ACDSee Trial “
Adobe Acrobat 5.0
Chineze [Simplified) Language Support
Chireze [Traditional] Language Support
Hebrew Language Support

HyperS nap-Dix

Irtel® 210 Chipzet Graphic Driver End Uzer Diagnostics Softws

Japanesge Language Support _:_j

AddiRemove. . 1

ok | cae | il |

Then click on the “Remove” button. A new prompt screen
will be displayed like the one below confirming the removal.

Click on the “OK” icon to continue the process or click on
the* Cancel” icon to rgect the uningtall process.

Confirm Uninstall

Do oy e booponnp el e moie Hra sobed e mop bost o mnd o of I pompoeenks?

ook caneet |
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The InstallShield Wizard prompt will appear and
“Finish” to complete the uninstallation procedure.

i s o o pleie
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APPENDIX

A Frequently Asked Questions

Inter net Camera Features

Q: What isalnternet Camera?

A: The Internet Camera is a standaone system connecting
directly to an Ethernet or Fast Ethernet network. It is different
from the conventional PC Camera, the Internet Camerais an all-
in-one system with built-in CPU and web-based solutions
providing a low cost solution that can transmit high qudity video
images for monitoring. The Internet Camera can be managed
remotely, accessed and controlled from any PC/Notebook over
the Intranet or Internet via aweb browser.

Q: What isthe maximum number of users that can be alowed to
access the Internet Camera smultaneoudy?

A: Maximum number of users that can log onto the Internet
Camera at the same time is 64. Please keep in mind the overdll
performance of the transmission speed will sow down when
many users are logged on.
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Q: What dgorithm is used to compress the digital image?

A: The Internet Camera utilizes the JPEG image compression
technology providing high quaity images for users. JPEG is
adopted since it is a standard for image compression and can be
applied to various web browser and application software without
the need to install extra software.

Internet Cameralnstallation

Q: Can the Internet Camera be used out-doors?

A: The Internet Camera is not weatherproof. It needs to be
equipped with a weatherproof case to be used outdoors and it is
not recommended.

Q: What network cabling is required for the Internet Camera?
A: The Internet Camera uses Category 5 UTP cable dlowing 10
Base-T and 100 Base-T networking.

Q: Can the Internet Camera be setup as a PC-cam on the
computer?

A: No, the Internet Camera is an Internet Camera used only on
Ethernet and Fast Ethernet network.

Q: Can the Internet Camera be connected on the network if it
consists of only private IP addresses?

A: The Internet Camera can be connected to LAN with private
I P addresses.
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Q: Canthe Internet Camera be installed and work if afirewall
exists on the network?

A: If a firewdl exigts on the network, port 80 is open for
ordinary data communication. However, since the Internet

Camera transmits image data, the default port 8481 is adso
required. Therefore, it is necessary to open port 8481 of the

network for remote users to access the Internet Camera
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B PING Your IP Address

The PING (Packet Internet Groper) command can determine
whether a specific IP address is accessible by sending a packet to
the specific address and waiting for areply. It can aso provide a
very useful tool to confirm if the IP address conflicts with the

Internet Camera over the network.

Follow the step-by-step procedure below to utilize the PING
command but first you must disconnect the Internet Camera
from the network.

Start a DOS window.
Type ping X.X.X.X, where x.x.x.x is the IP address of the Internet
Camera.

The succeeding replies as illustrated below will provide useful
explanation to the cause of the problem with the Internet
Camera | P address.
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C Trouble Shooting

Q: | cannot access the Internet Camera from a web browser?

Al: The possible cause might be the IP Address for the Internet
Camera is already being used by another device. To correct the
possible problem, you need to firs disconnect the Internet

Camera from the network. Then run the PING utility (follow the
ingructionsin Appendix B - PING Y our IP Address).

A2: Anocther possible reason is the IP Address is located on a
different subnet. To fix the problem, run the PING utility (follow
the instructions in Appendix B - PING Your IP Address). If the
utility returns “no response” or similar, the finding is probably
correct, then you should proceed as follows:-

In Windows 95/98/2000 and Windows NT, double check the IP

Address of the Internet Camera is within the same subnet as
your workstation.

Click “Start”, “Setting”, “Control Panel”, and the “Network”
icon.

Select TCP/IP from the “Network” dialog box and from the
“TCP/IP Properties’ dialog box click on “Specify an IP address’.
If the Internet Camera is situated on a different subnet than your
workstation, you will not be able to set the IP address from this
workstation. To verify make sure the first 3 sections of the IP
address of the Internet Camera corresponds to the first 3 sections
of the workstation. Therefore the IP address of the Internet
Cameramust be set from a workstation on the same subnet.
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A3: Other possible problems might be due to the network cable.
Try replacing your network cable. Test the network interface of
the product by connecting a local computer to the unit, utilizing a
standard Crossover (hub to hub) Cable. If the problem is not
solved the Internet Camera might be faulty.

Q: Why does the Power LED not light up constantly?

A: The power supply used might be at fault. Confirm that you
are using the provided power supply DC 5V for the Internet
Camera and verify that the power supply iswell connected.

Q: Why doesthe LAN LED not light up properly?

Al: There might be a problem with the network cable. To
confirm that the cables are working, PING the address of a know
device on the network. If the cabling is OK and your network is
reachable, you should receive a reply similar to the following
(...bytes=32time=2ms).

A2: The network device utilized by the Internet Camera is not
functioning properly such as hubs or switches. Confirm the
power for the devices are well connected and functioning.

Q: Why does the Internet Camerawork localy but not
externally?

Al: Might be caused from the firewall protection. Need to check
the Internet firewall with your system administrator.

A2: The default router setting might be a possible reason. Need

to double check if the configuration of the default router settings
isrequired.
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Q: Why does a series of broad vertical white line appears
through out the image?

A: A likely issue is that the CMOS sensor becomes overloaded
when the light source is too bright such as direct exposure to
sunlight or halogen light. You need to reposition the Internet

Camera into a more shaded areaimmediately as this will damage
the CMOS sensor.

Q: Thereisbad focus on the Internet Camera, what should be
done?

Al: The focus might not be correctly adjusted for the line of
sight. You need to adjust the Internet Camera focus manualy as
described in Adjust Internet Camera Focus.

A2: Thereis no adaptor fitted with your C-type lens. If you have
previoudy changed the supplied CS-type lens, you may have
unintentionaly installed a C-type lens without fitting the adaptor
first.

Q: Noisy images occur how can | solve the problem?

A1l: The video images might be noisy if the Internet Camerais
used is a very low light environment. To solve this issue you
need more lighting.

Q: Thereis poor image quaity, how can | improve the image?
Al: A probable cause might be the incorrect display properties
configuration for your desktop. You need to open the Display
Properties on your desktop and configure your display to show at
least 65' 000 colors for example at least 16-hit.
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Note:
Applying only 16 or 256 colors on your computer will produce
dithering artifacts in the image.

A2: The configuration on the Internet Camera image display is
incorrect. Through the Web Configuration Image section you
need to adjust the image related parameter for improve images
such as brightness, contrast, hue and light frequency. Please refer
to the Web Configuration section for detail information.

Q: There are no images available through the web browser?

A: The ActiveX might be disabled. If you are viewing the
images from Internet Explorer make sure ActiveX has been
enabled in the Internet Options menu. Alternatively, you can use
the Java Applet for viewing the required images.
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D I/O Connector

[/O Connector Definition for the Internet Camera

An 8pole connector is provided for auxiliary 10 connections to
the Internet Camera.

The 1O connector provides the physica interface for 2 digita
output and 2 digital input that is used for connecting a diversity of
external alarm devices to the Internet Camerasuch as |R-Sensor
and darm relay.

The digital input is used for connecting externa alarm devices
and once triggered images will be taken and e-mailed.

The supported transistor output can give a maximum of DC 5V to
the externally connected darm devices and once triggered the
current will activate the devices.

In11 |In11& In12isapair for digital input. It works at voltage 5V
In12

In21 |In21 & In22isapair for digital input. It works at voltage 5V
In22

Out1l+[Outl-& Outl+isapairfordigital out. The out put voltageis5
Out 1 - [V and maximum current is 100 mA

Out2+[Out 2-& Out 2 +isapair for digital out. The out put voltageis5
Out 2 - [V and maximum current is 100 mA
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|/O Schematic Diagram
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Warning

1. When connecting a device to the Input connector, the
device must be a passive component without voltage and
electrical current.

2. When connecting other devices through the Output
connector, please make sure the maximum current of DC
5V, 100mA is strictly observed.

3. Any failure of the above two points might cause serious
damage to the camera.

Through the Web Configuration in the Trigger section, you must
first enable the trigoer function. Please refer to the Web
Configuration section for detailed information.
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E Upgrade Firmware

User’s can update firmware from the IPView application. Select
“Camera” > “Properties’ and the Camera Property diaog box
will appear. Select the Tools tab and enter the full path of the
firmware binary file name in the Update Firmware field or you
can click on the “Browse” icon to sdect the file. Once the
firmware file is entered click on the “Update” icon to proceed
with the updating process. Once completed click on the “OK”
icon asillustrated below
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Warning

During firmware update process please make sure no interruptions will occur
asit might possibly cause serious damage to the Internet Camera
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F Time Zone Table

[GRAT 10007 E fit ajalein
[GMT-17:00] Midweay Island Samoa
[GMT-10:00] Hawai

[GMT-09:00) Alazka

(G T-08:00) Pacific Time [US & Canada); Tijuana
[GMT-07:00] Arizora

[GMT-07:00) Mountain Time [US & Canada)
[GMT-06:00] Central Time [LIS & Canada)
[GMT-06:00) Mexico City, Tegucigalpa
[GMT-06:00] 5 azkatchewan

(G T-05:00] Bogeta, Lima, Quito
[GMT-05:00] Eaztern Time [US & Canada)
[GMT-08:00] Indiana [East]

[GMT-04:00] Atlantic: Time [Canada)
[GMT-04:00] Caracas, La Paz

[GMT-04:00) 5 antiago

[GRT-03:30) Mewfoundland

[GhAT-03:00) Brazilia

[GMT-03:00) Buenos Airez, Georgetown

[GT-02:00) Mid-Atlantic

[GMT-01:00] Azores, Cape Verde =

[GMT] Cazablanca, Monrowvia

[GMT] Greemwich Mean Time : Dublin, Edinburgh, Lizbon, London
[GMT +07: 007 Amsterdam, Berlin, Bern, Rome, Stockhaolm, Wienna
[GMT+07:00) Belgrade, Bratizlava, Budapest, Liubliana, Prague
[GMT+07:00] Brussels, Copenhagen. Madrid, Pariz, Vilnius
[GMT+07:00] Sarajews, Skopje. Saofija, Warzaw, Zagreb

[GMT +02:00] Athens, lstanbul, Minzk

[GRT+02:00] Bucharest

[GMT +02:00] Caira
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[GMT+02:00] Harare, Pretaria

[GMT+02:00] Helzinki, Riga, T allinn
[GRT+02:00] Jeruzalem

[GMT +03:00) Baghdad, Kuwait, Rivadh

[GMT +03:00) Moscow, St. Petersburg, Volgograd
[GMT+03:00] Mairabi

[GMT+03:30) Tehrah

[GMT+04:00] &bu Dhabi, Muscat

[GMT+04:00] Baku, Thilizi

[GMT+04: 30] K.abul

[GMT+05:00) Ekaterninburg

[GMT +05:00] lslamabad. Farachi, Tashkent
[GMT +05:30] Bombay - Calcutta, Madias, Mew Delhi
[GMT+06:00] Astana, Almaty, Dhaka

[GRT +06:00] Colombo

[GMT +07:00) Eangkok, Hanoi, Jakarta
[GMT+03:00) Beijing, Chongging, Hong Kong, Ummgi
[GMT+03:00] Perth

[GMT +08:00) Singapore

[GRT+08:00] T aipei

[GMT+09:00] Ozaka, Sapporo, Tokpo
[GMT+03:00) Seoul

[GMT+03:00) % akutzk

[GMT +039:30) Adelaide

[GMT+03:30) Danwin

[GRT+10:00) Brizbane

[GMT +10:00) Canberra, Melbourme, Sydneyp
[GMT+10:00) Guam, Port Maoreshy
[GMT+10:00) Hobart

[GMT+10: 001 ladivostak

[GMT+08:00] Singapore

[GRT+08:00] Taipei

[GRT+09:00] Ozaka, Sapporo, Tokpo
[GMT+03:00) Seoul

[GMT+03:00) Y akutsk

[GMT+03:30] &delaide

[GMT+03: 30) Danwin

[GMT+10:00] Brizbane

[GMT+10:00] Canberra, Melbourme, Sydnep
[GMT+10:00) Guam, Port kaoreshy
[GMT+10:00) Hobart

GMT+10:00) Yladivostak,
[GMT+11:00] Magadan, Solomon |=.
[GRT +12:00] Auckland, wellingtan
[GRT+12:00] Fiji, Famchatka; Marshall |z
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G Xplug Control Installation

Installation To Web Server

Important Information
It is highly recommended to install the Xplug Control

application to the Web Server for IE 5.0. It must be
ingtalled to a Public Domain with Fixed |P address.

1. Installation:
Copy the “xplug.ocx” file to any WEB Server table.

2. Setting (Configuration):
From the Web Configuration menu select “System” and
under the “Loading ActiveX From” input web server
location
(http://www.web server location.com/).

Once the settings are completed the user now is able to access the
Internet Camera from the web browser by selecting the image
view — ActiveX mode.
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Installation To Local PC

Insert the CD-ROM into the CD-ROM drive to initiated the auto-
run program once completed a menu screen will appear as
follows:

Toinstall Xplug Control click on the " Xplug Control” button to
activate the ingtalation procedure for the plug-in program.

116



Once executed a prompt will appear requesting the input of the
desired language selection. Make the desired selection and click
on*“ OK” to continue.

Choose Setup Language

Select the language for this installation fiom
== i the choices helow.

The Welcome screen will appear. Click on the “Next” button to
proceed with the installation.

Walcome to the Installihsmld Wirard fee Hplag
Conhel
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core |
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The License Agreement prompt will appear as below. Read the
details carefully and click on the “Yes’ icon to continue with the

installation procedure.
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Click on the “Finish” button to complete Setup of the Xplug

Control Utility program for the Internet Camera.
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H Adjust Internet Camera Focus

The Internet Camera features an exchangeable CS-type lens that
can be used for different applications as necessary. It supports
rotational focus control so the lens can be adjusted to focus under
normal and stable conditions to maximize the image quality of the

Internet Camera.

To adjust the focus of the lens you need to turn the lens slowly in
either clockwise or anti-clockwise direction until the desired
image appears. DO NOT over turn the lens in ether of the
directions as it will be out of focus. Unless you want to substitute
the lens DO NOT unscrew more than 1.0mm apart from the Fixed
Lens Assembly.

Keep in mind while adjusting the Internet Camera's focus you
can review the image quality from the Web browser.

Fixed Lens Assembly
DO NOT adjust

CameralLens '= |
Adjust by turning —_—
clockwise or

counter-clockwise 119



Note:
You can further adiust the Internet Cameras image qudlity
through the Web Configuration under System Administration -
Image. Please refer to Web Configuration section for further
details.

Warning
Direct exposure to sunlight may cause permanent damage to the
CMOS sensor. Therefore do not expose the Internet Camera’s lens
directly to sunlight. When operation is required in glaring light
environment, it isrecommended to use an irislens.

The Internet Camera is designed for indoor usage and if your
application requires prolong exposure to sunlight, a sun visor is
recommended to protect the Internet Camera.

Replacing the Lens

Since the Internet Camerais designed with a CS- mount, the lens
equipped with the Internet Camera can be replaced with any
standard C or CS lens commonly used within the surveillance
industry.

Follow the instructions below to replace the supplied lens with
any C or CStypelens.

1. Unscrew the Internet Cameralens
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N

C-lens only, attach the new lens to a CS-C adapter

Screw the new lens onto the Internet Camera.  |If

appropriate, adjust the iris according to the prevailing light

conditions.

Refer to Adjusting the Internet Camera Focus on the previous
e.

ILI;ele?resh the web browser and monitor the results from the

Internet Camera.

/1_1:

d| ——
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| Specification

Video Specification

Resolution:
Sensor:

Gain control:
Exposure:
White Balance:
Shutter:
Minimum HHumination:
Foca Length:
Aperture:
Focus Extent:
Lens mounting:

Image (Video Setting)

Image compression:
Frame rate:

Compression Rate selection:

Frame rate setting:

Video resolution:
Brightness control:
Contrast control :
Hue control:

640 x 480 pixe

1/3" color CMOS sensor
Automatic

Automatic

Automatic

Electronics 1/60 ~ 1/15000 sec
2.5lux@F1.4, 3000K color

6.0 mm

f=1.8

20cm -8

Fixed board lens, CS-mount type

JPEG

30fps@QCIF, 20fps@CIF,
3fps@VGA

5level (Very Low, Low,
Medium, High, Very High)
1,5, 7,15, 20, auto (depends on
the video format)

160x120, 320x240, 640x480
Range 1- 128

Range 1- 128

Range 1- 128
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System Hardware
LAN Connector: One RJ45 port to connect to

10/100M bps Ethernet, auto-sensed

Generic 1/O Port: Four 1/O ports, two for input and two for
output
Tota 8pin:
Pinl Input Port (1)
Pin2 Input Port (1)
Pin3 Input Port (2)
Pin4d Input Port (2)
Pin5 Output Port (1+)
Pin6 Output Port (1-)
Pin7 Output Port (2+)
Pin8 Output Port (2-)
Note:

The output voltage is DC 5V and maximum current is 100mA.

LED Indicator: Power LED (Blue)
LAN Activity LED (Orange)
Note:
LED three mode setting can be changed by software. (Normal /
Off / Dummy)
Power Supply: DC 5V/2.4A, switching type

Power Communication: 4.5 Watt (900mA x 5V)

Communication Support
Communication: 10/200Mbps Ethernet only

Communication protocol: HTTP, FTP, TCP/IP, UDP, ARP,
ICMP, BOOTP, RARP, DHCP, PPPoE
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Browser Support
System requirement:

CPU: Pentium 11, 266 MHz or above
Memory Size: 32 MB (64 MB recommended)
VGA card resolution:  800x600 or above

?? Internet Explorer 5.0 or above (ActiveX & JAVA Mode—
View Image for Windows OS and JAVA Mode — View
Image for other OS)

?? Netscape 6.0 or above (JAVA Mode — View Image)

|IPView Application

Support OS: Win 98, Win 98 SE, Win 2000, Win Me, Win XP

System requirement for IPView:
CPU: Pentium 111, 450 MHz or above
Memory Size: 128 MB (256 MB recommended)
VGA card resolution:  800x600 or above

Operating environment

Operating temperature: 52C ~50°C

Storage temperature: -257C ~50°C

Humidity: 5% ~ 95% non-condensing
EMI

FCC, CE, VCCI
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G Glossary of Terms

NUMBERS

10BASET

100BASE-TX

A

Applet

ASCII

ARP

AVI

10BASE-T is Ethernet over UTP Category IIl, IV, or V
unshielded twisted-pair media.

The two-pair twisted-media implementation of 100BASE-T is
called 100BASE-TX.

Applets are small Java programs that can be embedded in an
HTML page. The rule at the moment is that an applet can only
make an Internet connection to the computer form which the
applet was sent.

American Standard Code For Information Interchange, it is the
standard method for encoding characters as 8bit sequences of
binary numbers, allowing a maximum of 256 characters.

Address Resolution Protocol. ARP is a protocol that resides at the
TCP/IP Internet layer which delivers data on the same network by
translating an | P address to a physical address.

Audio Video Interleave, it is a Windows platform audio and video
filetype, acommon format for small movies and videos.
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BOOTP

C

Communication

Connection

D

DHCP

Bootstrap Protocol is an Internet protocol that can automatically
configure a network device in a diskless workstation to give its
own | P address.

Communication has four components. sender, receiver, message,
and medium. In networks, devices and application tasks and
processes communicate messages to each other over media. They
represent the sender and receivers. The data they send is the
message. The cabling or transmission method they use is the
medium.

In networking, two devices establish a connection to communicate
with each other.

Dynamic Host Configuration Protocol was developed by
Microsoft a protocol for assigning dynamic IP addresses to
devices on a network. With dynamic addressing, a device can
have a different |P address every time it connects to the network.
In some systems, the device's |P address can even change while it
isstill connected. DHCP also supports a mix of static and dynamic
IP addresses. This simplifies the task for network administrators
because the software keeps track of IP addresses rather than
requiring an administrator to manage the task. This means a new
computer can be added to a network without the hassle of
manually assigning it a unique IP address. DHCP alows the
specification for the service provided by a router, gateway, or
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DNS

E

Enterprise
network

Ethernet

F

Fast Ethernet

Firewall

other network device that automatically assigns an IP address to
any device that requests one

Domain Name System is an Internet service that translates domain
names into |P addresses. Since domain names are alphabetic,

they're easier to remember. The Internet however, is really based
on | P addresses every time you use a domain name the DNS will
translate the name into the corresponding | P address. For example,
the domain name www.network_camera.com might translate to
192.167.222.8.

An enterprise network consists of collections of networks
connected to each other over a geographically dispersed area. The
enterprise network serves the needs of a widely distributed
company and operates the company’s mission-critical
applications.

The most popular LAN communication technology. There are a
variety of types of Ethernet, including 10 Mbps (traditional
Ethernet), 100 Mbps (Fast Ethernet), and 1,000 Mbps (Gigabit
Ethernet). Most Ethernet networks use Category 5 cabling to carry
information, in the form of electrical signals, between devices.
Ethernet is an implementation of CSMA/CD that operatesin a bus
or star topology.

Fast Ethernet, also called 100BASE T, operates at 10 or 100Mbps
per second over UTP, STP, or fiber-optic media.

Firewall is considered the first line of defensein protecting private
information. For better security, data can be encrypted. A system
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Gateway

Group

HEX

Intranet

Internet

designed to prevent unauthorized access to or from a private
network. Firewalls are frequently used to prevent unauthorized
Internet users from accessing private networks connected to the
Internet, especially Intranets all messages entering or leaving the
intranet pass through the firewall, which examines each message
and blocks those that do not meet the specified security criteria.

A gateway links computers that use different data formats
together.

Groups consist of several user machines that have similar
characteristics such as being in the same department.

Short for hexadecimal refers to the base-16 number system, which
consists of 16 unique symbols: the numbers 0 to 9 and the letters
A to F. For example, the decimal number 15 isrepresented asF in
the hexadecimal numbering system. The hexadecimal system is
useful because it can represent every byte (8 bits) as two
consecutive hexadecimal digits. It is easier for humans to read
hexadecimal numbers than binary numbers.

This is a private network, inside an organization or company, that
uses the same software you will find on the public Internet. The
only differenceisthat an Intranet is used for internal usage only.

The Internet is a globally linked system of computers that ae
logically connected based on the Internet Protocol (IP). The
Internet provides different ways to access private and public
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Internet
address

|P address

ISP

JAVA

information worldwide.

To participate in Internet communications and on Internet
Protocol-based networks, a node must have an Internet address
that identifies it to the other nodes. All Internet addresses are |P
addresses

Internet Protocol is the standard that describes the layout of the
basic unit of information on the Internet (the packet) and aso
details the numerical addressing format used to route the
information. Y our Internet service provider controlsthe IP address
of any device it connects to the Internet. The IP addresses in your
network must conform to IP addressing rules. In smaller LANS,
most people will allow the DHCP function of a router or gateway
to assign the I P addresses on internal networks.

IP address is a 32-binary digit number that identifies each sender
or receiver of information which is sent in packets across the
Internet. For example 80.80.80.69 isan IP address, it is the closet
thing the Internet has to telephone numbers. When you “call” that
number, using any connection methods, you get connected to the
computer that “owns” that | P address.

Internet Service Provider, is a company that maintains a network
that islinked to the Internet by way of a dedicated communication
line. An ISP offers the use of its dedicated communication lines
to companies or individuals who can’t afford the high monthly
cost for adirect connection.

Java is a programming language that is specialy designed for
writing programs that can be safely downloaded to your computer
through the Internet without the fear of viruses. It is an object-
oriented multi-thread programming best for creating applets and
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LAN

NAT

Networ k

NWay Protocol

applications for the Internet, Intranet and other complex,
distributed network.

Local Area Network a computer network that spans a relatively
small area sharing common resources. Most LANs are confined to
asingle building or group of buildings.

Network Address Translator generally applied by a router, that
makes many different |P addresses on an internal network appear
to the Internet as a single address. For routing messages properly
within your network, each device requires a unique IP address.
But the addresses may not be valid outside your network. NAT
solves the problem. When devices within your network request
information from the Internet, the requests are forwarded to the
Internet under the router's IP address. NAT distributes the
responses to the proper | P addresses within your network.

A network consists of a collection of two or more devices, people,
or components that communicate with each other over physical or
virtual media. The most common types of network are:

LAN — (local area network): Computers are in close distance to
one another. They are usually in the same office space, room, or
building.

WAN — (wide area network): The computers are in different
geographic locations and are connected by telephone lines or radio
waves.

A network protocol that can automatically negotiate the highest
possibl e transmission speed between two devices.
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PING

PPPOE

Protocol

Packet Internet Groper, a utility used to determine whether a
specific IP address is accessible. It functions by sending a packet
to the specified address and waits for areply. It is primarily used
to troubleshoot I nternet connections.

Point-to-Point Protocol over Ethernet. PPPoE is a specification for
connecting the users on an Ethernet to the Internet through a
common broadband medium, such as DSL or cable modem. All
the users over the Ethernet share a common connection.

Communication on the network is governed by sets of rules called
protocols. Protocols provide the guidelines devices use to
communicate with each other, and thus they have different
functions. Some protocols are responsible for formatting and
presenting and presenting data that will be transferred from file
server memory to the file server’'s net work adapter Others are
responsible for filtering information between networks and
forwarding datato its destination. Still other protocols dictate how
dataistransferred across the medium, and how servers respond to
workstation reguests and vice versa. Common network protocols
responsible for the presentation and formatting of data for a
network operating system are the Internetwork Packet Exchange
(IPX) protocol or the Internet Protocol (I1P). Protocols that dictate
the format of data for transferors the medium include token-
passing and Carrier Sense Multiple Access with Collision
Detection (CSMA/CD),implemented as token-ring, ARCNET,
FDDI, or Ethernet. The Router Information Protocol (RIP),a part
of the Transmission Control Protocol/Internet Protocol (TCP/IP)
suite, forwards packets from one network to another using the
same network protocol.
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RARP

RJ-45

Router

S

Server

SMTP

SNMP

Station

Subnet mask

T

(TCPIIP)

Reverse Address Resolution Protocol, a TCP/IP protocol that
allows a physical address, such as an Ethernet address, to be
translated into an | P address.

RJ-45 connector is used for Ethernet cable connections.

A router is the network software or hardware entity charged with
routing packets between networks.

It is a simple cmputer that provides resources, such as files or
other information.

The Simple Mail Transfer Protocol is used for Internet mail.

Simple Network Management Protocol. SNMP was designed to
provide a common foundation for managing network devices.

In LANS, astation consists of adevice that can communicate data
on the network. In FDDI, a station includes both physical nodes
and addressable logical devices. Workstations, single-attach
stations, dual-attach stations, and concentrators are FDDI stations.

In TCP/IP, the bits used to create the subnet are called the subnet
mask.

Transmission Control Protocol/Internet Protocol is a widely used
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Transceiver

UbP

ULP

User Name

Utility

UTP

WAN

transport protocol that connects diverse computers of various
transmission methods. It was developed y the Department of
Defense to connect different computer types and led to the
development of the Internet.

A transceiver joins two network segments together. Transceivers
can also be used to join a segment that uses one medium to a
segment that uses a different medium. On a 10BASE-5 network,
the transceiver connects the network adapter or other network
deviceto the medium. Transceivers also can be used on 10BASE
2 or 10BASE-T networksto attach deviceswith AUI ports.

The User Datagram Protocol is a connectionless protocol that
resides above IPin the TCP/IP suite

The upper-layer protocol refers to Application Layer protocols
such as FTP,SNMP, and SMTP.

The USERNAME is the unique name assigned to each person
who has accessto the LAN.

Itisaprogram that performs a specific task.

Unshielded twisted-pair. UTP isaform of cable used by all access
methods. It consists of several pairs of wires enclosed in an
unshielded sheath.

Wide-Area Network. A wide-area network consists of groups of
interconnected computers that are separated by a wide distance
and communicate with each other via common carrier
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Windows

Workgroup

Workstations

telecommuni cation techniques.

Windows is a graphical user interface for workstations that use
DOS.

A workgroup is a group of users who are physically located
together and connected to the same LAN, or agroup of users who
are scattered throughout an organization but are logicaly
connected by work and are connected to the same network group.

Workstation refers to the intelligent computer on the user’'s
desktop. This computer may be an Intel-based PC, a Macintosh, or
a UNIX-based workstation. The workstation is any intelligent
device a user works from.
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